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Welcome!
This tutorial will walk you through the entire process of building your own version of the
Broader Impact Dashboard. This includes installing Tableau Public, getting a copy of the Broader
Impact Dashboard Template, plugging in your own data, making basic customizations, and
more. If you are new to CollViz, please read through this tutorial carefully before you begin. If
this isn’t your first time building a CollViz dashboard, please feel free to skip around, as some
material will be common to all of the CollViz tutorials. You can click on a section title in the
Table of Contents (ToC) to skip right to it. Clicking the orange arrow in the bottom left corner
of any page will take you back to the ToC

Broader Impact Dashboard Summary
The Broader Impact Dashboard visualizes data about the impacts of a collection that are
outside of research and academia, including tours, volunteer opportunities, and serving specific
communities. This dashboard aims to help with assessing and sharing the role and importance
of a collection to the larger museum or institution, as well as showing how it is serving the
wider community. It assists with objectives such as:
•
•
•
•
•
•

Illustrating community participation across different types of engagement
opportunities.
Revealing insights and patterns into which communities are participating in different
opportunities.
Examining the success and growth of a specific program or event.
Seeing changes in total participation over time.
Identifying the time periods of high or low participation.
Communicating broader impact to others including administrators and grant agencies.
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This dashboard was designed to use a minimal and widely applicable dataset format. It is a
single table or spreadsheet. It requires the following columns at a minimum for the dashboard
to function properly:
•
•
•

•
•

Event Name
Event Category
Date

Community
Count

The dataset currently connected to this dashboard is just meant to act as a demonstrative
placeholder in the dashboard template until you replace it with your own dataset.
Here’s a Tip! Please note that while these exact headers are required, the actual content of these
columns is completely customizable and can be catered to your existing record keeping system and
priorities. For example, the placeholder dataset in this dashboard uses Tour, Volunteer, Campus
Course etc as values in the Event Category column, but any vocabulary could be used instead. Use
your own categorization that makes sense for you and your collection.

Some of the powerful features of this dashboard include:
•
•
•
•

A bar chart showing how many participants have engaged in each type of event.
A filled line graph illustrating the total participants by month over time.
Directly interactable charts, allowing you to hover over elements for more information and
to click elements to filter the entire dashboard to those selected datapoints.
A set of master filters that allow you to perform sweeping searches for communities, time
periods, or events of interest.

Want to take a test drive first? View and demo this dashboard on CollViz’s Tableau Public
Profile. A more detailed tour of its features and functions is included in the Dashboard Tour
section of this tutorial.
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Getting Started with Tableau
This section will cover the very basics of Tableau: how to install it, how it’s structured, where
the essential buttons are, and how to save a workbook. More detailed tasks will come later on.

I. Download Tableau Public
If you don’t already have it, you will first need to download the free data visualization
software Tableau Public on a computer running either macOS or Windows. Start by creating
a profile by clicking
on the top right. This will also take you to where you can
download the software.
Now that you have Tableau downloaded and a profile set up with a username and password,
open the program to follow along in the next section.

II. Tour of a Tableau Workbook

1. Navigating: Tableau is set up similarly to Microsoft Excel in a few ways. The entire
Tableau project is called a workbook. A single workbook is made up of individual
pages, shown as tabs along the bottom of the screen, just like in Excel. You will see
the renamable tabs for the pages you have already made, as well as buttons to add
new ones:
. Unlike Excel, there are two kinds of pages: worksheets and
dashboards. A worksheet is where you build a single visualization, and a dashboard
is where you assemble the worksheets together into one display.
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2. Data: All of the worksheets and dashboards of a workbook are pulling from the
same single data source, which you connect to when you open a new workbook. You
can preview or change the data source by clicking “Data Source” in the lower left
corner. Note: If you have not yet imported a dataset, this preview will not appear.
(See Connecting to your Dataset for more details).
3. Overview of a Worksheet (see below): The left column contains information from
the dataset. The Connected Dataset name will be at the top. Then, the Dimensions
(Qualitative fields) from your dataset will be listed out, followed by all of the
Measures (Quantitative Fields) below that. The next column has boxes that control
how the dataset is translated or encoded into the visualization. This includes where
you can assign data fields to the characteristics of the Marks in your visualization,
such as color or size, as well designating which data fields are acting as Filters. The
large center section is the actual Worksheet Canvas, which is where the visualization
itself is built.

Filters

Marks

Worksheet Canvas

Connected
Dataset

Dimensions
(Qualitative
fields)

Measures
(Quantitative
fields)

The data
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4. Overview of a Dashboard: A dashboard tab allows you to arrange any of the
worksheets and other elements (like filters, text and legends) into one display. The
Worksheets are listed out in the lefthand column, alongside options for Other
Objects to add to your dashboard like text and spacers. The central Dashboard
Canvas is where the elements are all arranged.
Dashboard Canvas

Worksheets

Other Objects
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III. Saving Tableau Workbooks
1. How to Save: This version of Tableau saves your workbooks to your online profile,
not locally on your computer, up to a total of 10 GB. To save a workbook, click on
the File dropdown menu in the upper left to find the “Save to Tableau Public” and
“Save to Tableau Public As…” functions, or simply click the floppy disk icon on the
top left of the window. Once you do, you’ll be asked to name the file, and once it
finishes saving, the direct webpage for the workbook on your public profile will
automatically load in a new tab in your default web browser.

IMPORTANT: Because Tableau Public loads and saves your workbooks online, you
will need a steady internet connection to be able to successfully save your work!
2. Controlling Privacy: Because Tableau Public only supports saving online to your
public profile, by default all of your workbooks will be publicly available on your
profile for viewing and downloading. This is exactly how you are able to view and
download all of CollViz’s templates. However, there are actions you can take to
control access to your workbooks.
a. Disable Downloading: You can manually turn off the ability for someone to
download your workbooks. To do this, go to your workbook webpage on
your Tableau Public Profile. Scroll down to the Details section below your
dashboard and click on “Edit Details”:
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b. Under Toolbar Settings, unselect the check box for “Allow workbook and its
data to be downloaded by others”. Then click “Save.” This will disable
anyone from downloading a copy of your dashboard. They can still view and
interact with the workbook online, however. To make a workbook invisible,
see the next step.

c. Toggling Workbook Visibility: You also have the option to toggle your
workbooks as “invisible” on your profile. This means that someone viewing
your profile gallery will not see that workbook, but they can see it if they
have the direct url to that workbook webpage. To toggle invisibility, go to
your Tableau Public Profile webpage and hover over the workbook. An eye
button will appear in the top right corner. Click once to set as invisible. Once
you move the mouse away, you should now see the crossed-out eye button,
indicating it is invisible. Click it again to reset as visible.

Visible

Toggle

Invisible

IMPORTANT: Toggling something invisible is not the same action as disabling download. If
someone can access to the workbook’s direct url, they can still download it. Toggling
invisibility only controls if it shows on your public profile gallery. CollViz recommends taking
both actions.
IMPORTANT: Please consider excluding or modifying data fields which may be inappropriate
or confidential depending on the audience and context. For example, staff contact
information, data about certain vulnerable communities, or data specific enough to identify
individual program participants.
Here’s a Tip! You can also set your profile settings to save your workbooks are invisible and unable to
download by default. Login to your Tableau Public Profile online, hover over your profile image icon in the
upper right corner of the screen, and click “Settings”. Under the first “Defaults” tab, you can check or
uncheck saving as invisible, or disabling downloads. Note: changing these settings will affect any saving you
do in the future, not any current workbooks saved to your profile.
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Let’s Make a Dashboard
This section will walk you through how to download and open the Broader Impact Dashboard
Template in Tableau, ensure your dataset is compatible, and then how to swap the placeholder
dataset with yours.

I.

Get your copy of the Dashboard Template
1. Downloading: You can find the Broader Impact Dashboard Template on CollViz’s
Tableau Public Profile. In the Gallery, click on the Broader Impact Template to go to
its page. Simply click the Download button in the top right of the dashboard:
. The workbook will download as a .twbx file. Save it somewhere easy
to find.
2. Opening:
a. Open Tableau Public.
b. Click “File” in the upper left, then click “Open…”

c. Navigate to where you saved the .twbx file, select it and click “Open.”
d. Tableau may take a few moments to open the workbook.
3. Saving: Save your workbook to your Tableau Public Profile right away. There’s no
need to worry about overwriting the original template since you can only save to
your own profile. (See Saving Tableau Workbooks if you need a refresher)

II. Prepare Your Dataset
1. Overview: The Broad Impact Dashboard has been designed to look for specific data
fields (column headers) in the connected dataset. It’s vital to have the same headers
in your dataset, or else the software will not be able to find what it’s looking for.
Please follow these instructions carefully, otherwise the dashboard cannot
communicate with your dataset.
2. Dataset structure: While Tableau can connect to a variety of file types, it’s
recommended to use one compatible with Microsoft Excel, such as a .csv or .xlsx.
The structure of your dataset should be a single sheet table with each row being an
instance of community participation (for example, k-12 students who were in a tour
on March 15th 2020). The maximum number of rows Tableau can process is 10
million.
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3. Minimum Data Field Requirements: The following is a table outlining the data fields
needed to ensure this dashboard works properly. The first column lists the exact
column headers, and the second column outlines the format the actual data needs
to be in. Note: Headers need to be exactly as displayed here. The columns can be in
any order, and more fields than these can be in the dataset, but not having these
listed here may prevent the dashboard from functioning properly.
Column header
Data Format and Description
Event name
(text) The name of a specific event, such as “Family Day” or
“Biology 101 Lab”. You can use whatever terms you like.
Event Category
(text) The category of event, such as “Volunteering” or “Tour”.
You can use whatever terms you like.
Date
(date)The date of the event, or if ongoing, the start date.
Include day, month and year.
Community
(text) The type of person counted, such as “Families” or “K-12”.
You can use whatever terms you like.
Count
(number) The attendance count for that specific community at
that specific event.
4. For Example: Here is an example from the placeholder dataset. This table is saying
that there was a Behind-the-Scenes Night on October 15th 2010, which is categorized
as a Tour. There were four communities recorded attending this event: 26
undergraduate students, 10 graduate students, 50 families, and 13 adults.
Event Name

Event Category Date

Community

Behind-the-Scenes Night
Behind-the-Scenes Night
Behind-the-Scenes Night
Behind-the-Scenes Night

Tour
Tour
Tour
Tour

Undergraduate Students
Graduate Students
Famlies
Adults

10/15/2010
10/15/2010
10/15/2010
10/15/2010

Count

5. Ensure your Dataset is Clean: While untidy datasets may not necessarily cause the
dashboard to fail, as they say in the data viz world, “garbage in, garbage out”. It pays
to take the time now to clean your dataset. And although in some cases the CollViz
dashboards may help identify problematic data, it’s not their intended use and
shouldn’t be solely relied upon. (See our website’s resources for guidance on how to
clean a dataset.)
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26
10
50
13

III. Connecting to Your Dataset
Tableau makes a live connection to a dataset, which means it maintains a one-way live link
with the dataset. So if you update the dataset, your workbook will too, but not vice versa.
When you are ready to connect to your dataset, all we need to do is swap it out with the
placeholder dataset currently in the dashboard.
1. Open the Broader Impact Dashboard Template Workbook in Tableau Public.
2. Click the Add New Data Source button in the upper left of the screen:

3. A blue menu will appear. You’ll find a list of file formats on the left side. Click on the
file type of your dataset:

4. A file explorer window will pop up. Navigate to your dataset and select it.
5. Tableau should then show a preview of your dataset, which includes the first 1000
rows.
a. If you do not see a preview and instead see big orange text saying “Drag
sheets here” that means your dataset has multiple sheets. Since Tableau can
only look at one at a time, simply find your desired sheet listed on the left of
the screen and drag-and-drop it into the big box to get the preview.
b. Look over the dataset to check that there were no glaring mishaps during the
connection process.
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c. Tableau will recognize your column headers and assign data types to your
fields: Text String
, Number , Geography , Date
etc. Make sure
these were assigned correctly, as shown in the following screenshot. If
something is not correct, simply click the symbol and choose the correct type
from the dropdown list.

6. If everything looks correct, navigate to any worksheet using the tabs along the
bottom of the screen.
7. Open the “Data” menu in the upper left, then click “Replace Data Source…”:

8. A small window will pop up. Make sure that the “Current” dataset is the placeholder and
the “Replacement” is set to your dataset. Click “OK”.

9. Every tab in this workbook should now be pulling data from your dataset, instead of the
placeholder. Check each worksheet and the dashboard for errors.
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10. Next, navigate to any worksheet. Locate the datasources in the top left corner of the screen.
Control-click on the placeholder dataset and click “Close” to remove it from your workbook
for good.

11. Save your workbook.
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Dashboard Tour
Title

Legend

Bar Chart

Filters
Line Graph

I. The Visualizations
1. Bar Chart
a. Parts: Event Categories are stacked along the y axis, and the Count of
participants is along the x axis. Community Categories are represented by
color. The entire bar of an Event Category represents the total participants,
with the breakdown by Community Category represented by the inner bars.
b. Interactions: Hovering over a bar will produce a tooltip box with more
information. Clicking on an inner bar or Event Category header will filter the
dashboard to include only those datapoints. You can hold the Command (⌘)
key while clicking to select multiple at a time, or click-and-drag. Click the
selection again or a blank space to undo the selection.
2. Line Graph
a. Parts: Participant Count is along the y axis, and chronological month and year
are along the x axis. The line represents the total number of participants of
that specific month across all events.
b. Interactions: Hovering over a point on the line will produce a tooltip box with
more information. Clicking on a point in the line or a Month Year label will
filter the dashboard to include only those datapoints. You can hold the
Command (⌘) key while clicking to select multiple at a time, or click-anddrag. Click the selection again or a blank space to undo the selection.
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II. Other Features
1. Legend: The legend contains the key for interpreting the Community Category
colors. These will update when applying filters.
2. Filters: This set of controls filter the entire dashboard. The timeframe can be

controlled by setting a Specific Year and/or Specific Month(s). You can filter to a
specific Community Category or Event using their respective dropdown menus.
Filters can be reset several ways:
1. Some can be reset by pressing the Esc key.
2. Double click on the Reset Filters button.
3. Click the Show All Values symbol in the upper right of the filter:
Here’s a Tip! There are many types of filters (such as dropdown lists) and you can set them
to accept single value or multiple values. To change a filter, click on it on the dashboard, and
then click the inverted triangle on the upper right to expand the menu:
choices in the third section of this menu.

You can see your

3. Title: This displays the dashboard’s name (the default being “Broader Impact”) and
can be easily changed. It also shows the last time the dashboard was updated and
the total count of participants, which will update as you filter the dashboard. The
“Last Updated” date needs to be changed manually. (See Customize for how to
change this information)
4. Help and Info Icons: Hovering over these icons shows extra information. Help
provides guidance on how to use the dashboard and its components. Info
provides details on the content of the dashboard, your organization, your dataset,
etc. It can also include contact information for who manages the dashboard and for
CollViz as the designer. These pop-up windows are called tooltips, and while they
contain example text, you can easily change it. (See the Customize section below.)
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Customize
Now that you understand the basic functions and features of your new dashboard, here are just
a few of the ways you could make you own customization. Check back with CollViz for updated
dashboard templates and extra tutorials for special customizations. NOTE: Make sure to reset
all your filters before starting any customizations.
I.

Moving and Removing Dashboard Elements: While the dashboard was designed in a
specific way, nothing is set in stone. You are free to make adjustments how you like, to each
piece’s dimensions, arrangement, or even if it’s there at all.
1. To resize an element, simply click on it in the dashboard to select it. Then, click-anddrag any of its edges to adjust the dimensions.
2. To move an element, simply click on it in the dashboard to select it. Then, click and
drag the grey tab sticking up on its top. Tableau shows you a preview of where it will
end up by highlighting the area of the new position in light grey.
3. To remove an element, simply click on it in the dashboard to select it. Then, click the
X button found in the top right corner of that element:

II. Changing Colors: You can change the entire color scheme or individual Community
Category colors.
1. Click on the Community Category color key in the Legend. Click on the inverted triangle
to expand the options menu.

2. Click “Edit Colors…”, which is the first option listed.
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3. To change the whole color pallet, choose another from the dropdown menu on the
upper right. Click “Assign Palette” to automatically change all the Community
Categories to those colors.

4. To change individual colors, you can either:
a. Click on the Community Category name on the left, then on your choice color
square in the palette on the right.
b. Double click on the Community Category name’s color square on the left, and
then you can pick any possible color.
5. Click “Apply” to preview your color changes on the dashboard. Click “OK” to enact
them.
II. Changing Tooltip Content: You can change what displays in the tooltip hover box of any
visualization.
1. Go to the worksheet of the visualization you would like to edit. (For example, if you
wanted to change the Help Icon tooltip text, go to the Help Icon worksheet using the
tabs on the bottom of the screen)
2. Click on the Tooltip button under Marks.
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3. In the popup window, you can add, change, or remove text. You can also change the
text’s color, font, size, alignment etc.
4. Anything highlighted in gray and between < > are live values pulled from the dataset.
For example, where you see <Event Category>, Tableau will pull that value from the
dataset and insert it there in the tooltip when you hover over a bar. Click “OK” when
finished.
5. To add a new live data field to the Tooltip, exit out of the Tooltip editor, and then click
and drag the field from the left column onto the Tooltip Button. Then click the Tooltip
Button to reopen the editor. Place your flashing line cursor where you want the live data
field to go, then click the “Insert” dropdown and click the data field from the list.

III. Changing the Title and Other Header Information: The information listed at the top of
the dashboard can be easily changed and updated.
1. To change the Dashboard Title, simply go to the dashboard and double click on the
title to open the text editor box.
2. To change the “Last updated” date, go to the Title Details worksheet tab at the
bottom of the screen. Click the Text Button under Marks, and then click on the
button to open the text editor box and make any changes you like. Click “OK” when
you’re finished.

Here’s a Tip! Want to make even more customizations? Tableau is a widely-used and very versatile
software, and there are plenty of resources out there about how to achieve what you have in mind. You
have free rein to change your dashboard however you like. You can find Resources, Discussion Board, and
Contact on the CollViz website.
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Put it to use
This section will show you how to use and share your dashboard in a few different ways.

I.

A Sample of Tasks
1.

2.

3.

II.

Querying using Filters: You can narrow down your dashboard to only show data
relevant to a set of criteria by applying multiple filters at once. For example, you can
filter down to only see K-12 participation across the spring of 2010.
Exporting Data: At any time, you can view and export the rows from your dataset that
are being displayed in the dashboard. Simply control-click anywhere on the dashboard
and click “View Data”. Then click “Full Data” on the bottom right corner of the popup
window. Click and drag to select which rows/columns/cells you like (or press Command
(⌘) +A to select all), then copy and paste into a spreadsheet. For example, you can
export the participation of different communities during the busiest month of the year
and insert those counts into a report.
Internal and External: Each CollViz dashboard is built to be useful for work within your
collection as well as communicating outwards. Be innovative when thinking of how this
one could be tailored for your priorities, objectives and current projects.

Sharing

You can share your dashboard as a static image or an interactable for a variety of audiences,
including researchers, administrators, colleagues, and even the general public.
1.

Static Screenshots are flat images of your dashboard, which can be saved, used in

presentations, printed onto posters, sent or posted online, embedded into a webpage,
etc. Tableau Public unfortunately doesn’t offer its own export function, so simply use
your device’s screenshot method (See this webpage for instructions for Mac or PC). You
can also download a jpeg, PDF or PowerPoint slide of a dashboard through your
Tableau Public Profile. Go to its webpage and click the Download button on the lower
right and select the file format you prefer:
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2.

Interactive Displays aren’t flat images but the interactive dashboard itself, with all of
the click and hover functions it has when open in Tableau. There are several ways to
use this format.
i. Presentation Mode: If you are going to be using a device that has Tableau
installed to present or share a dashboard, you can simply open your dashboard
and click the Presentation Mode button to go full screen, and press the escape
key to return:

ii.

iii.

Browser: An intractable version of your dashboard is located on your Tableau
Public Profile. This is the webpage that opens whenever you save your workbook
and where you downloaded the template from. You can navigate to it from your
profile’s gallery. The url for this page can be sent via email, hyperlinked in a
webpage, pulled up during a presentation, etc. Important: Unless you manually
disable download capability, anyone can download your dashboard, even if it
is toggled as invisible. Be certain to carefully assess the appropriate level of
privacy regarding the data. See the Saving Tableau Workbooks section for more
information about how to control privacy.
Embed: You can embed the dashboard itself into a website. You can find the
Embed Code for this interactive version on the dashboard’s direct webpage.
Here’s some more info on a helpful blog. Simply click the Share button
on
the lower right and copy the Embed Code into your webpage’s html code:

Here’s a Tip! Before sharing, presenting or publishing a dashboard, make sure to clear all filters and
selections before saving the final version. The workbook is saved as is and that includes whatever
manipulated state it’s in at the time that it’s saved. However, this also allows you to save different
versions of the same dashboard.
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Upkeep
Now that you have your individualized dashboard and know the basics of using Tableau, it’s
important to ensure your dashboard continues to work properly.
I. Dataset Changes: Any edits you make to the connected dataset will show in Tableau when
it is refreshed. You can even be working with both the dataset spreadsheet open and
Tableau open simultaneously. There are two ways to refresh the data connection.
1. Press Command (⌘)+R
2. Click “Data” in the top left, then hover over your dataset name, then click
“Refresh”):

II. Dataset Connection Errors
1. Important: Keep your connected dataset saved in the same location and with the
same file name, otherwise Tableau will not find it.
2. If your dataset is renamed or moved to a different folder location on your computer,
you will need to re-establish the connection, which you can do exactly the same way
as swapping datasets. See Connecting to Your Dataset for instructions.
III. Software Updates: Tableau will inform you of any available updates when you open the
program. The updates are usually minor and are very unlikely to impact your ability to open
and work with any workbooks you have. Update Tableau when it asks nicely to keep taking
advantage of their best offerings.
IV. CollViz Updates: CollViz is committed to improving its resources, in part thanks to your
help. Any feedback or suggestions will be taken into consideration and will inform new
updated versions of tutorials, resource recommendations, and even new dashboard
designs.
1. All previous versions of materials and dashboard templates will be saved in the
Archive section of the website, so upgrades will be voluntary and not automatic.
2. Check back frequently or subscribe to the email list to get notified of updates.
3. Check in with the Discussion Board to find questions and answers.
4. You can always Contact Jess directly for troubleshooting help, questions, or even
specific data visualization project ideas.
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